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Importing ICC Profiles 
 
When you need to add ICC profiles for a device, use the Import function.  
1. Choose Color Profiler from the Setup Menu.  

2. Choose a device from the Printer list. 

3. Click the Import button. 

4. The Import dialog box opens. 

5. Find the ICC profile you wish to import. Click Open.  

6. The ICC Profile Settings dialog box opens. 

7. The ICC profile is added to your device's list of profiles. 

Exporting ICC Profiles 
 
You may want to export ICC profiles for use in other applications, or to create an 
alternate version of an existing profile. 

1. Choose Setup>Color Calibration. 

2. Click on the Device from which you want to export a profile. 

3. Select the ICC profile to be exported. 

4. Click the Export button. 

5. The Export dialog box opens. 

6. Choose a Save location for the ICC profile. 

7. If you are making an alternate version of the profile, give the profile a new name in 
this dialog box. 

Creating an ICC Profile 
 
RCC II Plus gives you several options when creating ICC profiles. The steps for 
creating different profiles will vary depending on which option you choose.  Remember 
that when reading swatches, you should always place a number of layers of white paper 
under your print, to insure that you are not measuring the color of your desk through your 
printed sheet. 
 
Note- Swatches are printed with no color correction. You should not attempt to manually enable color correction 
for swatch prints from within Job Properties. 
 

Understanding Ink limits 
 
During the ICC profile creation process, you may be asked to print an Ink Limit Test to 
determine whether the media is capable of handling the amount of ink being printed. Ink 
limits will vary depending on the selected printer resolution. Higher resolutions will 
generally have more trouble with ink absorption, because the ink droplet size is not 
adjusted to compensate for the increase in the number of dots.  When looking at the Test 
Print, you should check the print to see if the swatches are over saturated. Symptoms of 
over saturation include: ink bleeding, color mixing, and ink that take an excessive amount 
of time to dry. 
If your Test Print looks fine, and colors do not appear to be over saturated, you can 
continue creating a profile 
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If you see over saturation in your Test Print, then you will need to determine which colors 
are over saturated, and the level where the saturation or bleeding occurs. You may need 
to do one or more Ink Limit Test Prints to determine the appropriate percentages. Be 
careful not to over-limit the swatches. Over limiting will reduce the number of viable 
points with which to produce a profile.  
 
1. Select the swatch before the over saturation or bleeding occurs. Each swatch is 

located in a column numbered 1-20. Each column number represents 5% increments 
of saturation.  

2. Multiply the column number of your swatch by five to determine the percentage to 
enter into the Ink Limit dialog.  For example, if you notice that bleeding occurs in the 
Cyan channel in column 18, you should enter 90 as the cyan ink limit.   

3. Do this for each channel that is over saturated.  

4. Print the Ink Limits again, make sure that the checkbox "apply the ink limit to the test 
print swatches" is checked. Applying the new ink limits to the test print swatches will 
help you determine if you have limited the inks properly.  

5. The swatches will print with the new ink limits applied. Check the printed swatches for 
any over saturation.  

6. Once you have acceptable ink limits, you may continue creating a profile. 

Understanding GCR 
 
GCR stands for Gray Component Replacement. The GCR settings determine the amount 
of black (K) that is used to replace black made by mixing CMY inks. When CMY are all-
present in a color there is a graying component. The greater the amount of CMY in a 
color, the darker the color is; however the combination of CMY does not produce a true 
black.  The higher the GCR is set, the more CMY black is replaced with K black. 
  
GCR settings will help control print quality, and reduce the amount of ink necessary for 
creating composite colors. When black is created by mixing three inks (CMY), often 
papers cannot handle having 300% ink saturation. A full saturation of 100% Cyan, 100% 
Magenta and 100% Yellow, will leave most papers wet, and may cause bleeding or 
unintentional mixing of colors. Replacing 300% ink coverage (CMY) with 100% coverage 
of K will produce a black using only 100% ink coverage, instead of 300%. It is also more 
economical to replace CMY with K, because you are printing with one ink instead of 
three.  
 

GCR Options 
 
In most cases the default options will produce excellent results. If you need to adjust the 
GCR, you can adjust the following options: 
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Total Ink Limit- This is a sum of the ink limit values for C, M, Y and K. Each color can have an ink 
limit of up to 100%; the total ink limit is a maximum of 300%. Increasing total ink limit may improve 
contrast of the print. 

Black Ink Start- This determines at which percentage of gray the black (K) channel begins to 
replace CMY. 

Black Ink Limit- This determines the maximum percentage of gray that the black (K) channel will 
replace CMY 

Understanding Advanced Options 
 
Before generating ICC profiles, you may choose to use the advanced options offered by 
RCC II Plus. Click the Advanced button in the generate profile dialog of Color 
Profiler. 
 
In most cases the default options will produce a quality ICC profile; however, if you need 
to adjust the advanced options you can adjust the following options: 
 

Option Definition 

Quality Specify whether you want a small, 
medium or large LUT (Look Up 
Table). Small LUT Profiles have a 
small file size, but are coarsely 
sampled.  Large LUT Profiles have 
larger file sizes, but have fine 
sampling. 

LUT Smoothing Choose whether you want no 
smoothing, mid, moderate, or 
heavy smoothing. This option will 
remove noise from the LUT. Use 
smoothing if the print shows 
sudden transitions, or banding. 

 

Create perceptual 
LUT 

This creates a different LUT 
specifically for the perceptual 
rendering intent (used for 
photographic images). If ‘create 
perceptual LUT’ is not checked, 
then relative colorimetric rendering 
intent will be used to create the 
LUT, and the profile will be smaller 
in size. 

Create saturation 
LUT 

This creates a different LUT 
specifically for the saturation 
rendering intent (used for business 
graphics). If ‘create saturation 
LUT’ is not checked, then relative 
colorimetric rendering intent will be 
used to create the LUT, and the 
profile will be smaller in size. 

Create preview 
tags 

This creates ICC preview tags 
('pre0', 'pre1', 'pre2') which contain 
preview LUT's. An ICC-compliant 
application may use these LUT's 
to perform printer output simulation 
(soft proofing). 

Save raw data- This option will save density and 
colorimetric data in the ICC profile. 
The data will identify the profile as 
a profile created by Color Profiler. 
Raw data provides support of the 
spot color rendering intent. If you 
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Option Definition 

wish to edit this profile in the future 
(change GCR or ink limits), then 
the raw data must be saved in the 
profile. 

Use private tags  This option produces files with a 
smaller size. Private tags are used 
to identify profiles shipped with RCC II
Plus software. 

 

 

 

Use ICC tags 

 

Resulting profile is an ICC profile 
with a larger file size and a correct 
hifi-color space. In addition, you 
can specify the hifi-color space 
signature. 

Color Mapping Allows you to create a customized 
gamut map that will map the 
primary colors to colors that can 
be achieved by the printer. The 
gamut map will be used whenever 
the input color is outside of the 
printer gamut. 

Source color Contain the 6 primary colors which 
you can specify in the device-
independent L*a*b* space color 
space. 

Destination colors Contain the corresponding colors 
to which you want the source 
colors to be mapped. You can 
specify these colors either in 
device-independent L*a*b* space, 
or in the printer’s native color 
space. However, the actual color 
used in gamut mapping is always 
the L*a*b* color. Colors specified 
in the printer space will be 
converted to L*a*b* color first. For 
example, if you specify C 0% M 
100% Y 100% K 0% for red, 
expect red to be printed with a 
similar color of red; however, do 
not expect the red to have the 
same exact values  C 0% M 100% 
Y 100% K 0%. 

RGB Setup This allows you to set up the 
display so that it shows an 
accurate simulation of what the 
colors would look like if they were 
printed. 

 

Creating a New Color Profile 

 
1. Select the Color Profiler option from the Setup Menu 

2. Select New Profile from the File Menu in Color Profiler 

3. Choose how you want to build the ICC profile:  

 
? Linearization and characterization  
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? Re-linearize existing profile  

? Characterization based on existing profile  

? Characterization without linearization 

 
When you choose an option to create a new ICC profile, you will be asked to supply 
some basic file information: 
 
Filename create a name for the file. You may wish to include ink or media abbreviations 
as well as the resolution in the file name to make it easier to identify the profile later. 
 

? Ink name of ink used 

? Media name of media used 

? Author who created the profile 
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Option Definition 

Comments Type any additional comments 
in this field. 

The "Advanced" 
button 

Brings up the Device ID dialog 
where you can fill in the printer 
Manufacturer and Model ICC 
signatures, which are four-
character codes. If present, 
these may be used by OS-
based drivers.  

Printer type "Color space" supported by the 
printer. 

Printer technology The type of ink used. CMYK, 
six color inks, thermal inks. 

Percent increments: 5% or 10% steps for each ink. 
Setting applies only to the 
density swatches. 

 

Target swatches: Number of patches used in 
gamut sampling, setting 
applies to the # of swatches 
printed for the target 
characterization swatches. 

Media size Sets size of all swatches to fit 
on media. 

Resolution Printer resolution. 

Color mode This may not be the same as 
Printer type. For example, a 
CMYK Printer type may have 
more than one color depth, 
such as CMYK(1-bit) and 
CMYK(2-bit). You may adjust 
specific driver options for your 
printer by clicking the Driver 
Options button.  
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Linearization and Characterization 
 
This option will give you a complete characterization, and is the recommended option for 
creating a new profile. 
 
1. Supply Basic File Information- You supply the file, ink, media names, and any 

optional comments. In the next dialog, you should also supply printer information 
such as: printer type, printer technology, density swatches, target swatches, media 
size, and print options.  
 

2. Check Ink Limits- Click the Test Print button and adjust ink limits if necessary. Below 
is an example of an ink limit test print.   

 

 
 
3. Print a Linearization Target - Choose to print a linearization target file (density file) by 

clicking the Print Target button. You may also choose to change your meter by 
clicking the Change button. Below is an example of a Linearization Target Print. 

 

 
 
4. Measure Density- Allow some time for the printed target to dry. Then click the 

Measure button, to launch the "Data Measurements" dialog. Click the Start button to 
begin measuring with your meter. If you wish to import data from another source 
instead, click the Import Data button and select the data you wish to import. 

 
5. Adjust Density Curves - The Color Profiler dialog displays the density data gathered 

from your measurements. In most cases, you will not need to adjust the density 
curves; however, if you suspect that the density data is incorrect, you can edit curves 
by clicking and dragging points on the curve to a new value. You can also type in 
specific values in the entry boxes to the right of the graph. To delete a point, select it 
and click the Delete button. 

 
Note- Editing should be done sparingly, and only if you know that the data is incorrect. Even if the density curve 
does not appear to be smooth, it may still reflect the true state of the printer.  
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Below is an example of a Density curve. 
 

 
 
Print Characterization Target- Choose to print a characterization target file (swatch table) 
by clicking the Print Target button. You may also choose to change your meter by clicking 
the Change button. Below is an example of a characterization target print. 

 
 
Note- this characterization target may appear different depending on the type of output device, the number of 
swatches you print, and the meter you are using. 

6. Measure Characterization Swatches- Allow some time for the printed target to dry. 
Then click the Measure button, to launch the "Data Measurements" dialog. Click the 
Start button to begin measuring with your meter. If you wish to import data from 
another source instead, click the Import Data button and select the data you wish to 
import. 

Note- when measuring swatches on backlit media, you should measure the swatches from the side that will be 
viewed. Do not measure the side on which the ink prints.  

7. Adjust GCR options - (if necessary) you may also enter percent values for total ink 
limits, black ink start, and black ink limit. 

 
8. Generate Profile- Choose from advanced options before generating the profile, or 

simply generate a profile using default options by clicking the Generate button.  

Re-linearize Existing Profile 
 
This option allows you to relinearize, or adjust an existing profile to the current condition 
of the printer. You can also use this option to compensate for density variation among 
different units of the same printer model.  
 
Note- You can only relinearize an existing profile if the existing profile was created with the "Linearization and 
Characterization" option. 
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1. Locate the Profile you wish to re-linearize, by clicking the Browse button. 

2. Edit the basic file information. 

3. Check Ink Limits   

4. Print a Linearization Target 

5. Measure Density.  

6. Adjust Density Curves if necessary 

7. Adjust GCR options if necessary. 

8. Generate Profile 
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Characterization Based on Existing Profile 
 
This option will build a characterization profile from an existing profile. To obtain a good 
profile, the printer and media must have similar characteristics to the existing profile. A 
typical application is to create a profile using a different print mode or different resolution. 
 
1. Locate the Profile you wish to characterize, by clicking the Browse button. 

2. Edit the basic file information. 

3. Check Ink Limits. 

4. Print a Linearization Target 

5. Measure Density 

6. Adjust Density Curves if necessary. 

7. Adjust GCR options if necessary. 

8. Generate Profile. 

 

Characterization without Linearization 
 
This option will build a new characterization profile, by skipping the Linearization. This 
method is not recommended unless your meter does not support density measurements. 
 
1. Supply Basic File Information  

2. Check Ink Limits  

3. Print a Characterization Target 

4. Measure Characterization Swatches 

5. Adjust GCR options if necessary. 

6. Generate Profile 

Editing ICC Profiles 
 
After an ICC profile has been created, you may edit some of the settings. The settings 
you may change include:  File, Ink, media, author names, GCR settings, and ink limits.  
Editing a profile will overwrite the existing ICC profile unless you change the file name. 
 
To edit a profile: 
1. Select the output device from which you wish to edit an ICC profile. 

2. Select Color Calibration from the Setup menu. 

3. Select the ICC profile you wish to edit from the list. 

4. Select Profile Properties from the Edit Menu 

5. The ICC Profile Settings dialog box opens. 

6. Change the available settings as desired  

7.   RCC II Plus regenerates the ICC profile to match the new settings. 
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Deleting ICC Profiles 
 
When profiles are outdated or no longer useful, you can delete them from the list. 

1. Select the output device from which you wish to delete an ICC profile. 

2. Select Color Calibration from the Setup menu. 

3. Select the ICC profile you wish to delete from the list. 

4. Click the Delete button. 

Factors Affecting Color Calibration 
Before you print test swatches, consider the following factors to maximize the quality of 
your color calibration: 

Option Definition 

Ink Each printer is designed with specific kinds of ink; 
therefore you should use the manufacturer-
recommended inks. Also, make sure the inks are 
filled and properly primed as instructed by the 
manufacturer. 

Media Media is the most important part of the ink and 
media interaction. This interaction between the ink 
and media coating affects every aspect of print 
quality, including color accuracy, vividness and 
durability, as well as the sharpness of your print. If 
the ink and media are not properly matched, 
potential problems include bleeding and smearing. 

Resolution Resolution is the measure of the dots per inch (DPI) 
of the printer. Changing the resolution affects the dot 
placement and the amount of ink laid down on the 
media by the printer. 

Environment Humidity and temperature affect the drying time for a 
print, which affects the ink and media interaction. A 
longer drying time can cause ink bleeding or 
intentional ink mixing. 

Print mode For the best results, calibrate using the printer's 
highest quality print mode. Using the quality mode 
will reduce banding. 

Print heads Print heads should be properly primed and all 
nozzles should be firing. The heads also need to be 
in alignment. Consult the printer manufacturer's 
documentation for instructions. 

Meter The spectrophotometer, colorimeter or densitometer 
needs to be calibrated properly for white points and 
black points. See your device's documentation for 
calibration instructions. 

Creating a Density Profile 

 
1. Select Density Adjustment from the Setup Menu 

2. Select New from the File Menu in Density Adjustment 

3. Choose how you want to create the density profile:  

? Densitometer readings  

? User specified values   

? Calibrate existing ICC profile 

Densitometer Readings 
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1. Supply Basic File Information- You supply the file, ink, media names, and any 
optional comments. In the next dialog, you should also supply printer information 
such as: printer type, printer technology, density swatches, target swatches, media 
size, and print options.  

2. Print a Linearization Target - Choose to print a linearization target file by clicking the 
Print Target button. You may also choose to change your meter by clicking the 
Change button. 

3. Measure Density- Allow some time for the printed target to dry. Then click the 
Measure button, to launch the "Data Measurements" dialog. Click the Start button to 
begin measuring with your meter. If you wish to import data from another source 
instead, click the Import Data button and select the data you wish to import. 
 

4. Adjust Density Curves - The Color Profiler dialog displays the density data gathered 
from your measurements. Edit curves by clicking and dragging points on the curve to 
a new value, or type in values in the entry boxes to the right of the graph. To delete a 
point, select it and click the Delete button.  

 
Note- Editing should be done sparingly, and only if you know that the data is incorrect. Even if the density curve 
does not appear to be smooth, it may still reflect the true state of the printer.  
 
1. Generate Density file by clicking the Finish button. 
User Specified Values 
1. Supply Basic File Information  

2. Adjust Density Curves   

3. Generate Density file. 
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Calibrate Existing ICC Profile   

1. Locate the profile you wish to calibrate, by clicking the Browse button. 

2. Supply Basic File Information. 

3. Print a Linearization Target. 

4. Measure Density. 

5. Adjust Density Curves. 

6. Generate Density file. 

Editing Existing Density Profiles 
 
There are two ways to edit density profiles: 
 
? Individual CMYK values 

? All Channels  

Individual CMYK values 

1. Select the profile you wish to edit from the list. 

2. Select Properties from the Edit Menu 

3. Edit file information or click on the Colorant field to select a color channel. 

4. Click the Edit button and edit curves by clicking and dragging points on the curve to a 
new value, or type in values in the entry boxes to the right of the graph. To delete a 
point, select it and click the Delete button. 
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All Channels 

1. Select the profile you wish to edit from the list. 

2. Select Properties from the Edit Menu 

3. Edit file information or click on the Colorant field to select a color channel. 

4. Click the Edit button and edit curves by clicking and dragging points on the curve to a 
new value, or type in values in the entry boxes to the right of the graph. To delete a 
point, select it and click the Delete button. 

5. Check the “apply curve to all channels checkbox. 

Note- Any modifications made to all channels will override changes you may have made to the individual 
channels.  

Using your Density Profile 
 
Density Adjustments can be routinely created to make adjustments for mechanical 
deterioration, such as old print heads, or varying environmental conditions. 
To use your Density profile: 
 
1. Select your output device and then choose the Setup Properties option from the 

Setup Menu. 

2. From the Print tab, select your density file from the Density adjustment field. 

3. All jobs sent to this setup will have this density adjustment applied to them, including 
any Ink Limit and Color Calibration swatches.  

 


